Ihe Plot™

The news letter for ZEH software users

Issue 31— Winter 2004

Welcome to Issue 31 of The Plot. Another year passes and hopefully lots of successful plots have
been output by your ZEH installation. The coming year should see some exciting new products, so
please check our company web page for new developments. If you have any information you would like
to share with other ZEH users, please let us know and we will include it in future copies of The Plot.

We would like to take this opportunity to wish our many ZEH customers around the world a peaceful,
prosperous, and healthy New Year. We look forward to working with you all in 2005.
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Events in 2003

We hope you find time to drop by the booth and see what ZEH has to offer for your site!

March 7-9 Houston, Tx 2005 Petroleum User Group Conference
May 16-19 Calgary, Alberta, CSEG National Convention
Canada
July 25-29  San Diego, Ca Twenty-Fifth Annual ESRI International User
Conference

Meet the Team — Robert Fitpatrick

In this issue of The Plot, you get to meet one of the U.S. based support representatives,
Robert Fitzpatrick. Robert joined the ZEH team in February 1999. One of Robert’s many roles at
ZEH is supporting Landmark Graphics and GeoQuest staff as well as other customers. He feels
fortunate to be able to help others use ZEH products to their fullest capacity and works to
improve the products at the same time.

His prior experience
comes from 21 years of
drafting for oil companies.
Most of that time was spent
at BP using various CAD
applications, including
MicroStation and ZEH
CGMage Builder. Robert
watched the computer
industry grow in the oil
patch from propriety
seismic processing only, to
complete full-featured
industry standard
applications like Landmark
Graphics and GeoQuest.
With the computer
generating seismic shot
point base maps faster than
drawing the maps by hand,
one shot point at a time, the drafting industry changed forever.

Robert grew up in Houston and married a native Houstonian. Together they have three
children, girls ages 17 and 15, and a son age 12. At home Robert enjoys do-it-yourself projects
and raising his three children in a Christian family atmosphere. As a family the Fitzpatricks enjoy
going to church, camping, and their family vacations.




Released this Year

PLOT EXPRESS Version 4.6.0

In September 2004, ZEH released PLOT EXPRESS Version 4.6.0 which includes the following:

e Added support for Red Hat Linux (vs. 3).

e Added support for iSys iTerra Pro printers.

e Added support for HP 100, 120, and 130 printers.

e Improved interfaces, accounting, rasterizers, and interpreters.

e Added a configurable option that cancels jobs taking longer than a predefined
amount of time.

e Changed Color Management licensing making color management a part of the base
PLOT EXPRESS product.

For more information, view the flyer at http://www.zehsoftware.com/theplot/
Whats_New_0704.pdf.

PLOT EXPRESS Version 4.5.0

Earlier this year, ZEH released PLOT EXPRESS Version 4.5.0 which includes the following:

e Added options when printing to PostScript-enabled small format devices.

e Added Active Directory authentication for ZEH users.

e Improved speed and reliability when processing HP-GL and HP-GL/2 files.

e Added support for processing PNG files.

e New printer utilization tracking when submitting from Windows-based applications.*
e Improved flexibility when printing from Windows applications through ZEH.*

e Streamlined submitting, searching, and navigation in ZEH Image Publisher.*

* Note: Some improvements were made to the add-on products to PLOT EXPRESS. These
add-ons include EnterPrize and ZEH Image Publisher. Please contact your ZEH sales
representative if you have questions concerning the products included in your license agreement.

For more information, visit the web at http://www.zeh.com/pdf/Whats_New45.pdf.
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C6Mage Builder

A new version of CGMage Builder is now available! This version supports Red Hat Linux 3,
7.1, 7.2, 7.3 (using the 2.4.x kernel) as well as support for 24-bit displays. If you are current on
maintenance and would like to upgrade your existing CGMage Builder installation, please contact
ZEH Technical Support. For more information on CGMage Builder, see its brochure at http://

www.zeh.com/pdf/cgmagebldr.pdf.

MicroStation V8 Support

Earlier this year, ZEH released a MicroStation submittal tool (MSUB) supporting Microstation
v8. This tool includes the following:

e Added support for MicroStation v8.
e Added a more intelligent interface directly to the main print server.
e Added printer accesses via the MySQL database.

e Improved access to some of the advanced features of the printers, such as Print
Quality or Roll Number.

¢ No transfer costs for all maintenance paying customers of the old v7 submittal tool
(ZPS-ZDFS).

For all customers having legacy v7 data, we have released a conversion tool to aid in your
migration to v8. This conversion tool will convert the Level Definition as used in ZDFS to a ZOR
table as now used within MSUB, or convert your file to a true WYSIWYG (What You See Is What
You Get) file. Again, if you are interested in this conversion tool, our contact information is on the
last page of The Plot.

IEH GIS Submittal

ZEH released several versions of ZEH GIS Submittal, the latest version being 2.2.1 which
includes the following:

e Full support for ArcGIS 9 in Version 2.2.1. GSUB Version 2.2.0 runs under ArcGIS 9,
but is not as efficient and large file sets may not print completely.

e Added support for tracking printing expenses by user and/or department.

e Support for PS level II output only and RLE or No compression. These values were
selected due to the reliability of the postscript output coming from ArcGIS.

e As of Version 2.2.0, added support for Windows 2003 Server.
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LEHServer Version 1.14

ZEH released ZEHServer Version 1.14 for use with Dassault Systemes CATIA® V5 Software.
Among other enhancements, the new release includes:

e Support for HP DesignJet 100, 120, and 130 printers. This feature requires PLOT
EXPRESS 4.6.0 or higher.

e Support for reading the PPD information for PostScript (PSTO) devices. This enables
advanced printing features such as tray selection. Also, the list of paper sizes are
read from the PPD file and are therefore printer specific.

e Cosmetic improvements to the Printer Setup dialog.

e Automatic connection to the next server in the list when the current server is down.
This behavior occurs in the Print dialog.

Success Stories

ZEH accumulates stories of customer successes using our various products. Below is a short
synopsis of the latest stories with a link to the complete story. Additional synopses can be found

at http://qis.zeh.com/gissuccess.html.

If you have a success story you would like to share with other ZEH customers, please let us
know. We will interview you and also write the story. All it requires is a few minutes of your time.

Department of the Municipality of Anchorage (MOA)

MOA supports users, such as the police and wildlife, that are spread out geographically
throughout Anchorage. With ZEHPlot for Workgroups, the MOA experienced a two-thirds time
reduction in printing, which allowed them to print 25 trail maps in one day. For the complete

story, see http://gis.zeh.com/pdf/MOA.pdf.
Washington Department of Fish & Wildlife (WDFW)

WDFW manages the fish, wildlife (including endangered species), and the acreages that
provide habitat and migration routes to the wild species. With ZEH software, the WDFW was able
to centralize UNIX and Windows processing and management on the same server and to track
which programs/users were consuming resources. For the complete story, see http://
gis.zeh.com/pdf/WDFW.pdf.
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1EH Customer Care Program

The customer support team at ZEH has been conducting rigorous customer care contacts
with current maintenance clients. As a part of the customer care program, clients are contacted
to check on their ZEH software status, update them on new releases, and generally check in with
the ZEH users to see how they are doing.

Clients are contacted either by phone or email (or both). Therefore, if you receive a call from
any of our support representatives, please let them know how you are doing and feel free to
question them about any new developments with the ZEH suite of software.

The Plot Delivered to Your E-Door

If you regularly pass The Plot to your co-workers and wish they had their own subscriptions,
pass this along instead. They can now sign up for their own copies of The Plot on the ZEH web
site at:

http://www.zeh.com/newsletter_request.html

You can also remove yourself from our newsletter mailing list by going to the same URL or

sending a request to press@zeh.com.

Software Installations and Training

Do you find it difficult to find the time to upgrade your ZEH installation, or are you perhaps
not comfortable attempting the process yourself?

If so, perhaps we can help.

The ZEH Customer Support team can provide the expertise and time to upgrade your system
for you, plus work with both the site administrator and users to ensure the system functions the
way you need it to. We can also ensure users are aware of new features and enhancements to
the installation.

We can perform one-on-one training and cater for your unique needs, or we can train groups
of users on specific areas of interest.

If you would like to find out more about what we can offer, and would like price information
for site visits, then please contact your nearest ZEH Customer Support team or your ZEH Account
Manager who will be happy to discuss our services with you.
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IEH Training Courses

ZEH is pleased to offer a number of
training courses at our US office in Houston
and also in the UK office in Dorking (near
London). A number of different courses are
currently available, as detailed below.

Many training courses can also be
provided at your site, if required.

We are always happy to discuss the
specific training needs of your company and,
where necessary, tailor the courses to those
needs. Courses at our training facilities in
Houston and Dorking are kept small to ensure
each delegate receives individual attention.

For more details on each of the training
courses, please visit our Web site at

http://www.zeh.com/training/

or contact your nearest ZEH office for more
details.

Training Course List

Western Hemisphere - Houston Office

Installation and Basic Users Workshop.
New to ZEH software? This workshop gets
you up and printing — and in control of the
system — in less than a day.

Basic Users’ Course. How to produce the
standard and customized prints you want.

CGM Workshop. Everything you need to
know about the CGM format, including how to
print its files.

Printing from MicroStation. Takes advan-
tage of special ZEH features when printing
from MicroStation 95.

Plot Express Administrator Workshop. Is
administering the printing system still daunt-
ing after a few months of working with it?
This workshop can help.

CGMage Builder Course. Understand the
basics of montaging with ZEH’s CGMage
Builder. Advanced topics are also covered.

QuickScope: Analyzing CGM Files with
ZCQS. See inside your CGMs.

Eastern Hemisphere - Dorking Office

ZEH UNIX PLOT EXPRESS 4 System
Managers/ZEH Windows PLOT EXPRESS
4 System Managers. Understand, install,
and configure PLOT EXPRESS 4.x on your sys-
tem.

Using CGM in the ZEH Environment.
Need a refresher course in CGM? This class
teaches you about VDC extents and view-
ports, and how to use them to get a terrific
print, among other topics.

CGMage Builder Workshop. Understand
the basics of montaging with ZEH's CGMage
Builder.

File Translations Using PLOT EXPRESS.
Whether converting from or to CGM, DGN,
HP-GL, and PostScript, this class can help you
work through color and font issues.

MicroStation Printing using ZEH (Begin-
ners, Advanced, or Combined). MicroStation
users at any level can benefit from this course
geared specifically toward use of ZEH Design
File Submittal.
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How To’s

Over the years we have covered a multitude of topics in The Plot and for new customers it is
understandably very difficult to know if we have perhaps touched on a topic before. What we will
try and do here and in future issues is to ask a variety of fairly typical questions that we are
asked in the Customer Support group. We will either point you to previous articles or just provide
a few hints and tips to help you resolve a specific issue.

How Do | Point fo More Than One FLEXIm License File?

A few customers asked how to reference more than one license file when having different
applications running discreet FLEXIm licenses. To point to more than one file or different license
servers, separate the license references by a colon in UNIX and a semicolon in Windows.

For example, on UNIX the LM_LICENSE_FILE variable may point to:
7754@serverl:7740@server2
On a Windows system it may be:

7754@serverl;G:\Security\GGXLIC.DAT

However, it is not always as simple as this and over the last few months we have seen cases
on Windows installations that do not conform to the above rules. For example, the simple semi-
colon as a separator on Windows has not always worked. We had to use a semicolon and comma
(;,) combination or include a space before the semicolon.

On sites running ERSI applications that require FLEXIm, we had to define the reference to the
ZEH license file before the ERSI license file.

So please bear in mind that even though in theory the license file separator should be a sim-
ple single character, you may have to experiment with slightly more complex combinations if the
licenses are not checked out correctly.

Can I Change the ZEH Web Interface Automatic Log Off?

With more users now using ZEH’s Web Interface, some customers are asking how they can
alter the time period so they are not automatically logged off quite so quickly. The good news is
this setting can be changed. To increase the time before you are automatically logged off:

1. Make a backup copy of the file first. The file used for making the change is:
e UNIX — $ZEHHOME/apache/jserv/etc/zone.properties
e Windows — %ZEHHOME%)\apache\jserv\etc\zone.properties

2. Open the file in a text editor.
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3. Search the file on session.timeout.
Notice that the value is set to 1800000. This is the millisecond value for 30 minutes.

4. Enter a number in milliseconds representing the length of time before the Web Interface
should automatically log out users.

For example, if you want the log off to be after 1 hour, alter the value to 3600000.

5. Save and exit the file.

Once changed, it is not necessary to restart apache for this change to take effect.

Can | See Which Client Node and User are Using the CGMage Builder?

The CGMage Builder is primarily a UNIX and Linux application for montaging CGM files. Most
sites using the application have a limited nhumber of licenses and usually more users than avail-
able licenses. This can cause problems if a user attempts to use the application and all the
licenses are checked out. However, the licenses may not necessarily be in use at that time. It is
all too easy to log onto a system, open an application, and then forget to terminate it when fin-
ished, or perhaps decided to work on another workstation but not terminated the original ses-
sion. Whatever the circumstances, the net result is that a license is checked out and was not
checked back to make it available for other users.

In a large organization, trying to physically find the offending user and machine may not be
simple. So what can be done to pinpoint who currently has a license checked out and from which
machine?

If we know this, freeing up a license may be a bit simpler. Information on license checkouts is
stored in the FLEXIm /mgrd./og file. Prior to version 4.6.0, the file resided in $ZPSPRG/zehd/log.
Since version 4.6.0, this file is now located in $ZEHHOME/logs.

For example, the following log file shows who checked out a key and from which machine:

10:52:58 (zehd) OUT: "ZPS-XCMP" adoyle@dorsn2

10:53:14 (zehd) IN: "ZPS-XCMP" adoyle@dorsn2

10:59:21 (zehd) OUT: "ZPS-XCMP" zehplot@dorsnl10 <<< client node
10:59:37 (zehd) IN: "ZPS-XCMP" zehplot@dorsn10

11:01:05 (zehd) OUT: "ZPS-XCMP" zehplot@dorsn10

11:01:22 (zehd) IN: "ZPS-XCMP" zehplot@dorsn10

You can either manually check the log file using vi or grep. If you want a dynamic display to
monitor activity and know at all times who is using the application, you can use the following
UNIX command:

tail -f Imgrd.log | grep XCMP

The same principle can be used to check the status of other applications for which you may
only have a limited number of licenses.
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8 or 24 Bit Displays — What I Am Running and Can I Change the Setfing?

Since Solaris 2.6, an option exists to install a 24-bit color plane for displays. As of Version
4.6.0, the CGMage Builder and CGM Previewer applications can run on either 8 or 24 bit color
mode displays. However, with previous releases, if the display was set to 24 bit, the following
error message displayed and the application did not run.

Error: Cannot find 8-bit PseudoClass visual

Can This Be Changed?

You can change the display settings by using the command m64config which can be found
in /usr/sbin. To determine what the current settings are as root, run:

me64config -propt

The above command returns something like:

--- OpenWindows Configuration for /dev/fbs/m640 ---
OWconfig: machine

Video Mode: 1152x900x76

Depth: 24

To change the screen to 8 bit mode, exit Windows and log in to the command line mode and
enter:

me64config -res 1152x900x76 -depth 8

It is not necessary to reboot the server to initiate the change. The 8 bit version of the
CGMage Builder and CGM Previewer should now run without any error messages.

Running Exceed in 24 Bit Mode

If you have a UNIX workstation setup for 24 bit color, and you want to run the 8 bit CGMage
Builder and display it back to a PC running Exceed, you can set this up as follows:

1. Right click Exceed in the toolbar.

2. Select Tools» Configuration.

3. Select the Video icon.

4. Change the Server Visual parameter to PseudoColor.

To run the 24 bit CGMage Builder and display back to Exceed, setup Exceed as follows:
1. Right click Exceed in the toolbar.

2. Select Tools» Configuration.

3. Select the Video icon.
4

. Change the Server Visual parameter to TrueColor.
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Running Exceed v7.1.0.0 in 24 Bit Mode

With this version of Exceed, the setting for Server Visual can be found beneath Screen Def-
inition and not Video. To check and/or change the setting:

1. Right click Exceed in the toolbar.
2. Select Tools» Configuration.

3. Select the Screen Definition icon.
4

. On the Screen 0 tab, change the Server Visual parameter to PseudoColor.

Running Linux in 8 Bit Display Mode

To configure Linux for 8 bit mode, you need to run the program Xconfigurator which can be
found in /usr/X11R6/bin. This should be run from the console where X is not started. The utility
allows the display to be set for 8 bit mode, if required for the CGMage Builder.

When using this utility, use the space bar to place an asterisks alongside the required display
mode. If you do not select the mode in this manner, an error message displays when the
system attempts to configure the display settings.

Once set to a valid 8 bit format, the 8 bit version of the CGMage Builder and CGM Previewer
run correctly on a native Linux system.

Paneling — What Is It and Why Do | Need If?

For many users the first time they are aware of paneling is when a print panels and they
were not expecting it!! In these circumstances it may not be the desired result, but there are
occasions when paneling is a very useful feature; particularly when printing very large images.

What is Paneling and What Controls If?

ZPANEL, the paneling feature for PLOT EXPRESS, is a utility allowing printed output larger
than the width of the printer (Y paneling) and longer than the length of the media (X paneling)
to be split into "panels". These panels are then attached manually for a complete print output.

The use of paneling is determined by the following:
e Type of paneling set up.
e Whether the user submitting the job chooses to use the paneling feature.

Although the system administrator can set up paneling for all print jobs, the user may opt to
suppress paneling altogether.
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What Types of Paneling are There?

The following are the two types of paneling:

¢ Full-mode paneling — Printed output is paneled to fill the width and/or length of the
printer until the last panel, which is simply the remainder. This is the default method for
paneling.

o Half-mode paneling — Printed output is split into panels of equal size.

Assume you want to print a 12" by 20" image to an A4 paper size as illustrated below.
Width - Y

Length- X paper

size

image
size

ZEH can print the image using either full-mode or half-mode paneling as follows:

Full mode Paneling Half mode Paneling
{ Panell | Panel3 | Panell | |! Panel3 !
! Panelz ||| Panel4 | Panel2 | |! Panel4 !
TR ¢ M- :

Notice with half-mode paneling, only the width (Y direction) uses the half-mode paneling
method.
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How Does ZEH Know When to Panel?

When a printing device is configured in ZEH, two specific parameters controlling the maxi-
mum width and length that can be printed for that particular model of printer are set. These are
the Bytes per Scan (width) and the Number of Scans (length).

The values set for these parameters are from database tables and are calculated based on
information we know about the particular device. We take into account if the device accepts con-
tinuous rolls of media and their width, or just individual cut sheets e.g. A4, A3 etc.

What Do These Parameters Actually Mean in Layman's Terms?

To see the values set for these two parameters, use the Web Interface and select Admin »
Printers » Modify » Device.

Admin
Image Publisher
Alerts Size Settings
Johs
Queues
Devices Bytes per Scan: |1 333
Printers
Add

Modify Number of Scans: |239354
Pronerties

Device

Access

Ao Raster density: 300

Load Balancing
Synchronize i
Users Plotter density: 300
Accounting
Cost Centers
System

Stamne

Bytes per Scan

The Bytes per Scan defines the maximum width that can be printed and is derived from the
following equation:

Bytes per Scan = ( maximum printable width in inches x DPI ) / 8
At first glance the value may not be that helpful if you are not use to the displayed numbers.
However, as long as you know the Bytes per Scan, you can back calculate the maximum printable
width before an image panels. For example, assume the Bytes per Scan is set to 1333 and the
DPI to 300. The maximum printable width is:
maximum printable width = (1333 x 8 )/ 300 = 35.55 inches

So if an image you process has a width greater than the value set for the Bytes per Scan, it
forces the output to panel.
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Number of Scans

The Number of Scans defines the maximum length that can be printed and is derived from
the following equation

Number of Scans = maximum printable length x DPI

With most roll fed devices, the figure you see is usually a large value, as in theory the limit is
how much paper is on the paper roll. Even the longest well logs should fit onto a roll fed device,
unless insufficient paper is loaded!!

A typical setting for a 300 dpi roll fed HP RTL printer is 239864. This equates to:
maximum printable length = 239864 / 300 = 799.5 inches = 66.62 ft = 20.31 m

With a cut sheet device taking A4 or A3, the value for Number of Scans is not as large as it is
for a roll fed device and equates to the true printable length of the configured page size.

What Can | See in the Log File to Know if a File Has Paneled?

For every job processed through ZEH, the plotex./og is generated. This file can be found in
the wrk\jobid folder on Windows and in wrk/server/jobid on UNIX. The log file shows details as
to whether a file required paneling or whether it was printed without the need for any paneling.

These are the typical entries if no paneling is required:

%ZPANEL-I-VERSION, Copyright 2004 Zeh Software, Inc. Version 3.0.9
%ZPANEL-I-MODE, Full mode panelling

%ZPANEL-I-NOPANEL, No panelling required

%ZPS-PANEL Paneling complete

Running decision for phase 8: c2hp_disable

These are the typical entries if the output requires paneling. There is information to indicate
if the output paneled in X, Y, or both directions.

%ZPANEL-I-VERSION, Copyright 2004 Zeh Software, Inc. Version 3.0.9
%ZPANEL-I-MODE, Full mode panelling
%ZPANEL-I-OVERLAP, Y overlap is 0.5 inches
X overlap is 0 inches
%ZPANEL-I-PANEL, panelling required, number of panels = 2
%ZPANEL-I-KCOL, Finished panelling color, 2
%ZPANEL-I-KCOL, Finished panelling color, 3
%ZPANEL-I-KCOL, Finished panelling color, 4
%ZPANEL-I-NUMP, The number of Y panels is 2
no x panelling requiredZPANEL-I-CREATE, Creating parfiles for each of the panels.
%ZPS-PANEL Paneling complete
Running decision for phase 11: c2hp_disable

To find out more about paneling, please refer to Chapter 15 of the PLOT EXPRESS System
Administrator Guide.
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ISUBC — Command Line Job Submittal Plus

Hopefully, most customers are aware of the product JSUB+ either through reading about it in

previous copies of The Plot or by using it as part of your ZEH Installation.
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Are you, however, aware there is also a command line option called JSUBC. It allows you to
submit through the command line without using a GUI. This option is documented in the PLOT
EXPRESS Users Guide, “Chapter 8 - Using Job Submittal Plus Command Line”, but a brief over-
view is given here to illustrate how to use it and how it may be able to help you.

Job Submittal Plus is a Graphical User Interface for submitting metafiles to ZEH's plot man-
agement system. Its counterpart, Job Submittal Plus Command Line, is a command line version
of this same product, also allowing for submittal into ZEH's PLOT EXPRESS system. The com-
mand line version automatically installs when Job Submittal Plus is installed. The executable is
named jsubc for UNIX and jsubc.exe for Windows; and is located in the bin directory where Job

Submittal Plus was installed.
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To run the command line option, you need to enter the following commands on one long line:

On UNIX
$ZEHHOME/bin/jsubc -server server_name -host hostname -port db_port_number
-plotter plotter files files_to_submit -user plotex_user -usergroup access_level -
password password

On Windows
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path_to_ZEHHOME\bin\jsubc.exe -server server_name -host hostname
-port db_port_number -plotter plotter -files files_to_submit -user plotex_user
-usergroup access_level -password password

The login switches are -user, -usergroup, and -password. You can enter values for these
switches, or not use them and have the application display the User Login dialog.

where

-server server_name The server alias used for PLOT EXPRESS. To find the server
alias, cd to the $ZEHHOME/config (or change to the
%ZEHHOME%\config if running under Windows) directory
and look at the db_user_address line of the plotex.cfg file.
The name within the mysgl command is the server name
to use.

-host hostname The actual machine name of the node where PLOT
EXPRESS is installed.

-port db_port_number The PLOT EXPRESS database port.
-plotter plotter The name of the PLOT EXPRESS printer to submit to.

files files_to_submit The file(s) to be submitted. This field does accept
wildcards as well as parameter files.

-user plotex_user The user name for PLOT EXPRESS. If user authentication is
turned on, a valid user name must be used. If user
authentication is turned off, then the user name can be
anything, but not left blank.

-usergroup access_level The access level (user, operator, or administrator) to use.

-password password If user authentication is turned on, the password is tied to
the user. If no user authentication is being used or if PLOT
EXPRESS Version 4.2.5 or lower is being used, the
password must be the password associated with the group
(not the user). If there is no password for a group and/or
user, enclose the string in quotes (- password "").




Now this may appear to be rather complex, but rest assured, it isn't that bad! The very first
time you use the command line option, you need to add entries for all of the parameters. This
information is then stored in the jsubc.properties file in the users HOME folder on UNIX and for
Windows in the C:\>Documents and Settings\username\Application Data\zeh directory.

If the submittal is successful, the jsubc.properties file is created and contains entries like the
following:

#Zeh Properties

#Wed Dec 01 10:22:28 GMT+00:00 2004
plotex.server=dorlp20.zeh.co.uk

plotex.plotter=hp1055
batch.database=mysql(dorlp20.zeh.co.uk:7755@plotex,user,user)

Once this file exists, all that should be required from that point forward is the -files switch.

The following images show the dialogs displayed on a typical Windows system when jsubc
was used to submit a CGM file to an HP1055 printer.

C:\path>c:\zeh\bin\jsubc.exe -server dorlp20.zeh.co.uk -host dorlp20.zeh.co.uk
-port 7755 -plotter hp1055 -files c:\zeh\testfiles\cgmtest_met.cgm -user user
-usergroup user -password ""

WWINNT system32' cmd.exe
“Documents and Settingssadoyle?c:szehsbinsjsubec.exe —server dorlp2B.zeh.co.uk I’

—host dorlpZ@.zeh.co.uk —port 7755 —plotter hplBS5 —files c:szehstestfilesscgmte
st_met.cgm —user user —usergroup user —password "
oading server information
onnecting to: [dorlpZ@.zeh.co.uk:?756 and dorlpZB.zeh.co.uk:77681
oading data for server: [dorlp2B.zeh.co.ukl
eading table: [plotterl
eading tahle: [usergrpsl
eading tabhle: [plotter_cfgsl
oading gqueues information
eading tabhle: [translators]
eading tabhle: [gueue_exec]
eading tabhle: [hatch_dgn_units]
eading tabhle: [hatch_permissions]
eading table: [hatch_io_types]
eading table: [hatch_page_sizes]
eading tabhle: I[media_size=s]
eading table: [vp_groups_printer_mapl
eading tabhle: [vp_users_printer_mapl
eading tahle: [vp_groups_user_mapl
eading table: [vp_groups_project_mapl
eading tahle: [vp_users_project_mapl
eading tahle: [watermarksl
eading tahle: [text_stamps]
eading tabhle: [image_stamps]
eading tabhle: [plotter_infol
eading tabhle: [cost_centers]
eading tabhle: [cost_center_members]
eading tahle: [zip_fields]
eading tahle: [zip_serverl
eading tahle: [projects]
eading tabhle: [ppd_informationl
i tabhle: [plotter_ppds]
tahle: [hatch_plotter_keywords]
[hatch_plotters]
: [hatch_keywords ]
transfer ...
information
scanning: [cgmtest_met.cgml
percentComplete: [B.A1]
percentComplete: [18H@.81
scanning: [cgmtest_met.parl
percentComplete: [B.A1]
percentComplete: [18H.81
Submitted as Plotex Job #26
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As the file is submitted, information displays which can be helpful if any of the input data is
incorrect or if the syntax is wrong. If for example when the printer is specified with an incorrect
name, you see:
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C:~\Documents and SettingssadoyleXc:szehshinsjsubc.exe —sevver dorlpZ2B.zeh.co.uk
—host dorlpZ@.zeh.co.uk —port 7755 —plotter hplB53 —files c:szehstestfilesscgmte
st_met.cgm —user user —usergroup user —password "
oading server information

onnecting to: [dorlpZ@.zeh.co.uk:?756 and dorlpZB.zeh.co.uk:77681
oading data for server: [dorlp2B.zeh.co.ukl
eading table: [plotterl

eading tahle: [usergrpsl

eading tabhle: [plotter_cfgsl

oading gqueues information

eading tabhle: [translators]

eading tabhle: [gueue_exec]

eading tabhle: [hatch_dgn_units]

eading tabhle: [hatch_permissions]

eading table: [hatch_io_types]

eading table: [hatch_page_sizes]

eading tabhle: I[media_size=s]

eading table: [vp_groups_printer_mapl

eading tabhle: [vp_users_printer_mapl

eading tahle: [vp_groups_user_mapl

eading table: [vp_groups_project_mapl

eading tahle: [vp_users_project_mapl

eading tahle: [watermarksl

eading tahle: [text_stamps]

eading tabhle: [image_stamps]

eading tabhle: [plotter_infol

eading tabhle: [cost_centers]

eading tabhle: [cost_center_members]

eading tahle: [zip_fields]

eading tahle: [zip_serverl

eading tahle: [projects]

eading tabhle: [ppd_informationl

eading tabhle: [plotter_ppds]

eading tahle: [hatch_plotter_keywords]

eading table: [hatch_plotters]

eading table: [hatch_keywords]

nahle to locate plotter: [hpliA531]

C:sDocuments and Settingssadoylel_

If the server name is specified incorrectly, the response is:

C:sDocuments and Settings™adoyle>c:szehvhinsjsubc.exe —server dorlr2@.zeh.co.uk
—host dorlrZ2@.zeh.co.uk —port 7755 —plotter hplBA53 —Ffiles c:-szehntestfiles“cgmte
st_met.cgm —uUsSer user —usergroup user —password "

Loading server information

linabhle to estabhlish connection to Plot Express database.

C:sDocuments and Settingssadoyle>




After a successful submittal, the command line dialog to the same server and printer can be
reduced to:

C:\path>c:\zeh\bin\jsubc.exe -files c:\zeh\testfiles\cgmtest_met.cgm

CAWINNT system32h cd.exe

C:»Documents and Settings“adoyleXc:szeh~bin“jsubc.exe —files c:\zeh\testfiles\cgl’

test_met.cgm

cading szerver information

onnecting to: [dorlp2B.zeh.co.uk:?75%6 and dorlpZB.zeh.co.uk:77681

cading data for server: [dorlpZB.zeh.co.ukl

Reading tabhle: [plotterl]

Reading tabhle: [usergrps]

Reading tabhle: [plotter_cfgsl

cading gueues information

Reading tabhle: [translators]

Reading tabhle: [gqueue_exec]

Reading tabhle: [hatch_dgn_units]

Reading tabhle: [hatch_permissions]

Reading tabhle: [hatch_io_tuypes]

Reading tabhle: [hatch_page szizes]

Reading tabhle: I[media_sizes]

Reading table: [vp_groups _printer_mapl

Reading tabhle: [vp_users_printer_map]l

Reading tabhle: [vp_groups_user_mapl

Reading table: [vp_groups _project_mapl

Reading table: [vp_users_project_map]l

Reading tabhle: [watermarks]

Reading tabhle: [text_stamps]

Reading tabhle: [image_stamps]

Reading tabhle: [plotter_infol

Reading tabhle: [cost_centers]

Reading tabhle: [cost_center_members]

Reading tabhle: [zip fieldsl

Reading tabhle: [zip serverl

Reading tabhle: [projects]

Reading tabhle: [ppd_informationl

Reading tabhle: [plotter_ppds]

i i tabhle: [hatch_plotter_keyuwords]
[batch_plotters]
[batch_keywords ]
transfer ...
information

[cgmtest_mgg.cgm]
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percentComplete: [188.81
scanning: [cgmtest_met._.parl
percentComplete: .81
percentComplete: [188.81
Submitted as Plotex Job #H27

C:~Documents and Settings“adoyle’

Can | Submit Multiple Files af the Same Time?

Yes. For example, to submit all .cgm files in the current directory to the hp1055 printer using
the same server as used in the previous example, use the command:

C:\zeh\testfiles>c:\zeh\bin\jsubc.exe -files *.cgm

Fun7l Submit a File to a Different Printer Than the One Specified in jsubc.proper-
jes?

Yes. To override the jsubc.properties setting and print to the device epson3000, use the com-
mand:

C:\zeh\testfiles>c:\zeh\bin\jsubc.exe -plotter epson3000 -files raster.jpg




Can I Use Extra ZEH Keywords?

Yes. Assume we wanted to include the keyword cutlines=yes when we submit a file, we can
add the keyword as follows:

C:\zeh\testfiles>c:\zeh\bin\jsubc.exe -files testfile.cgm -cutlines yes

This overrides whatever the cutlines default settings is for the printer being used and writes
cutlines=yes into the parameter file. If the keyword itself or its value is invalid, it does not get
written to the parameter file.

Can I Add Multiple Keywords Referenced from Another File?

Yes. You can also place keyword values in a flat file (one keyword per line) and pass the file
to the command line using the -settings switch. The command line interface writes whatever is
in the file to the parameter file. The file either needs to reside in the current directory or be ref-
erenced with a full path. Assume the c¢:|temp|keys.textfile contains the follow keywords:

cutlines = yes
copies = no
dither_mode = poster

The command to use in this instance is:
C:\zeh\testfiles>c:\zeh\bin\jsubc.exe -files testfile.cgm -settings c:\temp\keys.txt

Hopefully this gives you some ideas as to how you can use JSUBC in your environment. It is
a very powerful and easy to use option and many customers are now making use of this product.
If you need further information, please check out the ZEH Bookshelf or contact your local Cus-
tomer Support Team.

—
=
()
|
—
- e 1
s |
—
-
==
()




Web Interface — How fo Disable Options

Some customers have expressed a desire for certain options in the Web Interface to be dis-
abled, so users in general cannot access certain features. In this article the technique for doing
this is detailed. Please make sure you backup your original files before making any changes so
you can revert back to the original setup should there be a need.

In this example we will see how we can disable access to the Utilities » Plugin menu.

Wersion 4.6.0

User: username
Server: dorlp20.zeh.co.uk

Submit

Status

Puhlisher

Litilities
Preterences
Default printers
Switch server
Downinad printers
Plugin

Help/FAQ
Bookshelf
Logout

1. Make a backup copy of the file first. The file used for making the change is:

e UNIX — $ZEHHOME/apache/jserv/zeh/classes/menu.en

e Windows — %ZEHHOME%)\apache\jserv\zeh\classes\menu.en

2. Open the file in a text editor.

| menu.en - WordPad

File Edit WYiew Insert Format Help

D[|@| S| 4| & [=(@[-] ®|

BEGIN

HENUITEM Submwit PATH Submit ALCTICN MPGetFile 3EC 1

POPUP Status
BEGIN
HMENTUITEHM
HMENTUITEHM
HMENTUITEHM
HMENTUITEHM
HMENTUITEHM
END

PATH Status 3EC 1

Devices PATH 3tatus_Devices ACTION Deviceltatus 3EC 1
Queues PATH 3tatus Queuss ACTION ZhowlUserQueuss 3EC 1

Jobs PATH Ztatus_Jobs ACTION JobTable 3EC 1

Printers PATH 3tatus Printers ACTION ZhowlUserPrinters 3EC 1
System PATH 3tatus_System ACTION Plotexitatus 3EC 5

HENUITEM Publisher PATH Publisher ACTION PublishLink LICENSE ZPS-ZPUE 3JEC 1
POPUP Utilities PATH Utilities SEC 1

BEGIN
HENUITEH
HENUITEH
HENUITEH
HENUITEH
HENUITEH
HENUITEH

END

Preferences PATH Utilities Preferences ACTION Preferences 3EC 1

Default printers PATH Utilities_befault+printers ACTICN UserDefsultPrinters 3EC 1

Change password PATH Utilities Change+password ACTION UserChangePasswd AUTH plotex _only, ldap plotex 3EC
Switch server PATH Utilities 3witch+server ACTION ZJwitchierver 3EC 1

Download printers PATH Utilities Download+printers ACTION PCPrinterDownload 3EC 1

Plugin PATH Utilities Plugin ACTICN Header ?headerPage=Fluginlnstall.wm 3EC 1

POPUP Admin PATH Adwin 3EC 5

BEGIN
1]

Zor Help, press F1
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3. Find the 19th line which looks like:
MENUITEM Plugin PATH Utilities_Plugin ACTION Header?headerPage=Plugininstall.wm SEC 1

4. Change the SEC 1 parameter to denote the appropriate user access level.

You can set this level to 5 for operator access, 10 for administrator only access, or 15 to
disable the option entirely for all authentication levels.
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5. Save the file and exit the editor.
6. Either close and re-open, or refresh the web browser page.
You do not need to stop/restart Apache or PLOT EXPRESS for the change to take effect.

The Utilities » Plugin menu now appears grayed out/disabled for those users whose access
level has been restricted.

Version 4.6.0

User: username
Server: dorlp20.zeh.co.uk

Submit

Status

Puhlisher

Liilities
Preferences
Default printers
Switch server
Nnwnlnad printers

Help/FAQ
Bookshelf
Logout

This same technique can be used with any of the menu options in the Web Interface.
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